
User Guide
English

Connex500/350
3-D Printer System





DOC-13000 Rev. E

Copyright
Copyright © 2010 Objet Geometries Ltd. All rights reserved. 
This documentation contains proprietary information of Objet Geometries Ltd. This information is 
supplied solely to assist authorized users of Connex500/350 3‐D printing systems. No part of this 
document may be used for other purposes, and it may not be disclosed to other parties. 
The specifications on which this document is based are subject to change without notice.
No part of this book may be reproduced in any form or by any means, nor stored in a database or 
retrieval system, without prior permission in writing from Objet Geometries Ltd.
If this document is distributed as a PDF file, you may print it for internal use.

Trademarks
The following are registered trademarks of Objet Geometries Ltd.: Objet®, FullCure®.
The following are trademarks of Objet Geometries Ltd.: Eden, Eden500V, Eden350V, Eden350, 
Eden330, Eden260, Eden260V, Eden250, Connex, Connex500, Connex350, Objet30, Objet24, Alaris, 
Alaris30, PolyJet, PolyJet Matrix, CADMatrix, PolyLog, Objet Studio, Job Manager, SHR, TangoBlack, 
TangoBlackPlus, TangoGray, TangoPlus, VeroBlue, VeroGray, VeroWhite, VeroWhitePlus, VeroBlack, 
Durus, DurusWhite, RoseClear, Clear, ObjetGreen, Digital Materials.
Microsoft and Microsoft XP are trademarks of Microsoft Corporation.
All names of products and services cited in this book are trademarks or registered trademarks of their 
respective companies. 

FCC Compliance
The equipment referred to in this guide has been tested and found to comply with the limits for a 
Class A device pursuant to part 15 of the FCC rules. These limits provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. Objet 3‐D 
printing systems generate, use and can radiate radio‐frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference, in which case 
the user will be  required to correct the interference at his own expense. 
The 3‐D printer referred to in this guide contains a transmitter module, FCC ID: YH6‐RFID. 
NOTE: Objet Geometries is not responsible for radio or TV interference caused by unauthorized 
modification to this equipment. Such modification could void the user’s authority to operate the 
equipment.

Equipment Recycling
In the European Union, this symbol indicates that when the last user wishes to discard a product, it 
must be sent to appropriate facilities for recovery and recycling. For information about proper 
disposal, check your purchase contract, or contact the supplier of the equipment.

   
 
 
 
 
 
 
 
 
 
 
 

Limitation of Liability
The product, software or services are being provided on an “as is” and “as available” basis. Except as 
may be stated specifically in your contract, Objet Geometries Ltd. expressly disclaims all warranties of 
any kind, whether express or implied, including, but not limited to, any implied warranties of 
merchantability, fitness for a particular purpose and non‐infringement.
You understand and agree that Objet Geometries Ltd. shall not be liable for any direct, indirect, 
incidental, special, consequential or exemplary damages, including but not limited to, damages for 
loss of profits, goodwill, use, data or other intangible losses (even if Objet has been advised of the 
possibility of such damages), resulting from: (i) the use or the inability to use the product or software; 
(ii) the cost of procurement of substitute goods and services resulting from any products, goods, data, 
software, information or services purchased; (iii) unauthorized access to or alteration of your 
products, software or data; (iv) statements or conduct of any third party; (v) any other matter relating 
to the product, software, or services. 
The text and drawings herein are for illustration and reference only. The specifications on which they 
are based are subject to change. Objet Geometries Ltd. may, at any time and without notice, make 
changes to this document. Objet Geometries Ltd., for itself and on behalf of its subsidiaries, assumes 
no liability for technical or editorial errors or omissions made herein, and shall not be liable for 
incidental, consequential, indirect, or special damages, including, without limitation, loss of use, loss 
or alteration of data, delays, or lost profits or savings arising from the use of this document.



iv  

 

Patents
This product is covered by one or more of the following U.S. patents:
5,263,130
5,287,435
5,386,500
5,519,816
5,695,708
6,259,962
6,569,373
6,644,763
6,658,314
6,850,334
6,863,859
7,183,335
7,209,797
7,225,045
7,300,619
7,364,686
7,368,484
7,369,915
7,479,510
7,500,846
7,604,768
7,628,857

Objet Geometries Ltd. 
http://www.objet.com

DOC‐13000
Revision Rev. E
November 2010

http://www.objet.com


DOC-13000 Rev. E

1 About This Guide
Using This Guide ............................................................................................................................... 1–2
For More Information........................................................................................................................ 1–2
Terms Used in This Guide................................................................................................................ 1–3

2 Safety
Safety Features ................................................................................................................................... 2–2
Symbols and Warning Labels .......................................................................................................... 2–3
Safety Guidelines ............................................................................................................................... 2–4

Printer Installation .............................................................................................................................. 2–4
Printer Operation ................................................................................................................................ 2–4
UV Radiation ....................................................................................................................................... 2–4
Printer Maintenance ........................................................................................................................... 2–4
Model and Support Materials ........................................................................................................... 2–5

First Aid for Working with Printing Materials.............................................................................. 2–6
Contact with Skin................................................................................................................................ 2–6
Contact with Eyes ............................................................................................................................... 2–6
Ingestion............................................................................................................................................... 2–6
Inhalation ............................................................................................................................................. 2–6

Waste Disposal ................................................................................................................................... 2–7

3 Introducing the Connex 3‐D Printing System
Welcome to Connex........................................................................................................................... 3–2
Work Configurations......................................................................................................................... 3–3
Source Files ......................................................................................................................................... 3–4

STL Files ............................................................................................................................................... 3–4
SLC Files............................................................................................................................................... 3–4

Connex Workflows............................................................................................................................ 3–5
Printing Materials .............................................................................................................................. 3–6

Storage .................................................................................................................................................. 3–6
Shelf Life............................................................................................................................................... 3–6
Exposure to Light................................................................................................................................ 3–6
Safety Considerations......................................................................................................................... 3–7
Disposal ................................................................................................................................................ 3–7

Work Environment ............................................................................................................................ 3–7
Workstation Requirements............................................................................................................... 3–8
Preparing Files for Use with Connex 3‐D Printing Systems ....................................................... 3–9

Converting CAD Files to STL Format.............................................................................................. 3–9
Converting Files to SLC Format ....................................................................................................... 3–9

Objet Studio Software ..................................................................................................................... 3–10

4 Installing Objet Software
How to Install Software for the Connex 3‐D Printing System .................................................... 4–2

Contents



Connex500/350  

vi

5 Using Objet Studio
Opening Objet Studio........................................................................................................................ 5–2

Toolbars.................................................................................................................................................5–2
Preparing Models for Production.................................................................................................... 5–3

OBJDF Files: Overview.......................................................................................................................5–3
Opening Model Files...........................................................................................................................5–3
Opening STL & SLC Files...................................................................................................................5–3
Opening Objet Digital Files................................................................................................................5–5
Copying and Pasting Objects.............................................................................................................5–7
Selecting Objects ..................................................................................................................................5–8
Splitting Objects into Components ...................................................................................................5–8
Model‐Material Settings .....................................................................................................................5–9
Digital Materials ................................................................................................................................5–10
Assigning a Model Material to Objects ..........................................................................................5–11
Coating Objects ..................................................................................................................................5–12
Assigning Properties to Hidden Objects........................................................................................5–13

Arranging the Objet Studio Screen................................................................................................ 5–14
Positioning Objects on the Build Tray .......................................................................................... 5–16

Automatic Positioning ......................................................................................................................5–16
Manual Positioning ...........................................................................................................................5–17

Model Orientation............................................................................................................................ 5–18
Manipulating Objects on the Build Tray ...................................................................................... 5–19

Object Position on the Z‐Axis ..........................................................................................................5–19
Repositioning Objects .......................................................................................................................5–20
Valid Object Placement ....................................................................................................................5–22
Grouping and Ungrouping Objects ................................................................................................5–22
Using a Grid to Position Objects .....................................................................................................5–23
Changing an Object’s Orientation...................................................................................................5–24
Freezing an Object’s Orientation.....................................................................................................5–25
Surface Finish .....................................................................................................................................5–25

Display Options................................................................................................................................ 5–26
Display Colors....................................................................................................................................5–28
Displaying Large Files ......................................................................................................................5–29
Tray Viewing Options ......................................................................................................................5–30

Handling Completed Trays............................................................................................................ 5–32
Tray Validation ..................................................................................................................................5–32
Production Estimates ........................................................................................................................5–33
Printing Modes ..................................................................................................................................5–34
Saving the Tray File...........................................................................................................................5–35
Printing the Tray File ........................................................................................................................5–35

Additional Objet Studio Features .................................................................................................. 5–39
Dividing Objects ................................................................................................................................5–39
Choosing the Support Strength .......................................................................................................5–39
“Smartcast”—Filling Models with Support Material...................................................................5–40
Displaying the Cross Section of Objects.........................................................................................5–41
Printing the Screen Display on Paper.............................................................................................5–41
Saving the Screen Display as an Image File ..................................................................................5–42
Exporting and Importing Objet Build Trays .................................................................................5–42

Advanced‐Mode Features .............................................................................................................. 5–43
Save Tray As…...................................................................................................................................5–44
Configuring the GL Driver...............................................................................................................5–45



User Guide

DOC-13000 Rev. E vii

6 Using Job Manager
Client Job Manager ............................................................................................................................ 6–2

Job Manager Screen ............................................................................................................................ 6–3
Job Manager Operations .................................................................................................................... 6–4
Configuring User Alerts..................................................................................................................... 6–4

Server Job Manager ........................................................................................................................... 6–6
Job Manager Screen ............................................................................................................................ 6–7
Job Manager Operations .................................................................................................................... 6–8
Making changes to a Job .................................................................................................................... 6–9
User Alerts ......................................................................................................................................... 6–10
Sending the Tray to the 3‐D printer for Production .................................................................... 6–11

7 Operating & Maintaining the Connex500/350 3‐D Printer
Starting the Connex Printer.............................................................................................................. 7–2
Loading Model and Support Cartridges ........................................................................................ 7–4
Producing Models.............................................................................................................................. 7–5

Printer Interface Color Key................................................................................................................ 7–7
Printing Indicators .............................................................................................................................. 7–8

Resuming Production After Printing has Stopped ....................................................................... 7–9
Changing the Model Material ........................................................................................................ 7–10
Keeping the Connex Printer in Idle Mode ................................................................................... 7–15
Shutting Down the Connex Printer............................................................................................... 7–16
Maintaining the Connex Printer .................................................................................................... 7–18

Routine Maintenance Schedule....................................................................................................... 7–18
Cleaning the Print Heads................................................................................................................. 7–19
Pattern Test ........................................................................................................................................ 7–21
Improving Print Quality .................................................................................................................. 7–22
Cleaning and Replacing the Wiper ................................................................................................ 7–23
Cleaning the Roller Waste Collector and Inspecting the Roller Scraper (Knife) ..................... 7–25
Replacing the Roller Scraper (Knife).............................................................................................. 7–28
Aligning the Print Heads................................................................................................................. 7–30
Calibrating Print Heads ................................................................................................................... 7–34
Replacing Print Heads...................................................................................................................... 7–40
Testing and Calibrating the UV Lamps......................................................................................... 7–49
Calibrating the Load Cells ............................................................................................................... 7–51
Replacing the Odor Filter ................................................................................................................ 7–52
Replacing the UV Lamps ................................................................................................................. 7–52
Built‐in Tests ...................................................................................................................................... 7–57
Replacing the Waste Container....................................................................................................... 7–62
Cleaning the Exterior Panels ........................................................................................................... 7–64

8 Handling Printed Models
Removing Models After Printing .................................................................................................... 8–2
Removing the Support Material ...................................................................................................... 8–2
Storing Models ................................................................................................................................... 8–3



Connex500/350  

viii



DOC-13000 Rev. E 1–1

About This Guide

Using This Guide................................................................................. 2
For More Information ......................................................................... 2
Terms Used in This Guide.................................................................. 3



About This Guide

1–2  DOC-13000 Rev. E

Using This Guide
This user guide provides instructions for installing, operating and 
maintaining Connex 3‐D printing systems. It explains how to use features, 
and provides practical examples to guide you as you use the system.
The text and figures in this guide are based on the Connex500 3‐D printer, 
printer software version 57.1.0.5491 and Objet Studio software version 
8.5.1.5.
This guide assumes that:
• all the hardware, software, and network components of your Connex 

system are installed, configured, and operating correctly.
• the operator has a working knowledge of the Windows® PC platform.

For More Information
Visit http://www.objet.com/ for more details about Objet’s technology, 
products and consumables, and for service and support contacts.
For other documents that relate to Connex500/350 3‐D printing systems, 
and for this document in other languages, contact your regional Objet 
Customer Support office.
If you have any questions about the information presented in this 
document, or if you have any comments or suggestions for future editions, 
please send a message to support@objet.com.

http://www.2objet.com/ 
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Terms Used in This Guide

build tray In Objet Studio: The surface displayed on the screen that 
represents the actual build tray in the Connex printer.
In the Connex printer: The surface upon which models are 
produced.

cleaning fluid Cleanser for flushing model feed tubes and the printing 
block, used to completely remove model material from the 
system before loading another type of material in the printer. 
The cleaning fluid is supplied in model‐material cartridges.

client/user workstation The workstation on which Objet software is installed, used 
for preparing build trays for production on Connex printers. 
(There is no limit to the number of client workstations in the 
local network.)

Connex™ printer The Objet 3‐D printer referred to in this guide.

Connex computer The computer inside the Connex printer that operates it. (This 
is sometimes referred to as the “embedded” computer.)

Connex printer interface The GUI (graphical user interface) used for controlling the 
Connex printer.

Connex software Software running on the computer inside the Connex printer 
that controls all printer operations.

Digital Material™ Combinations of model materials fabricated on the Connex 
printer from the two basic model materials installed.

Digital Material Mode The printer mode used to print a job using two different 
model materials. (This mode can also be used to eliminate the 
need for performing the Material Replacement procedure 
when printing with a single model material.)

host/server workstation The workstation on which the full version of Job Manager is 
installed. This workstation interfaces directly with the 
Connex printer and is typically positioned next to it.

Job Manager™ The software that manages production jobs before they are 
sent to the Connex printer. 

mixed part Models whose parts are printed using more than one model 
material.

mixed tray A build tray containing objects, each of which is designed to 
be printed using a different model material.

Model material Material used for building models.

Objet Studio™ The software with which users prepare jobs for producing 
models.

OBJDF (Objet Digital Format) The extension of a file that contains information about the 
geometry of an object and the materials required to print it. 
objdf files are created in Objet Studio. (For more information, 
see page 5‐3.)



About This Guide

1–4  DOC-13000 Rev. E

OBJTF (Objet Tray Format) The extension of a file that contains all of the information 
needed for a model‐printing job on Objet 3‐D printers. An 
objtf file is used to send a print job to an Objet 3‐D printer.

OBJZF (Objet Z Format) The extension of a compressed “wrapper” file containing all 
of the files used in an Objet Studio build tray. Using objzf files, 
a printing job can be saved as a single file, for convenient 
storage and transfer.

PolyJet Matrix™ The technology of printing models by jetting multiple 
materials simultaneously from the print heads. This 
technology enables Connex500/350 printers to print in Digital 
Material mode.

resin The base substance from which photopolymer printing 
materials are made for use in Connex printers. In Objet 
Studio, Job Manager and Connex software, “resin” refers to 
cartridges of model and support materials.

SLC A file type used with Objet software. (These files are bitmaps 
of individual slices of the object. For more information, see 
page 3‐4.)

STL A file type used with Objet software. (For more information, 
see page 3‐4.)

Support material Material used for supporting the structure of models during 
production.



DOC-13000 Rev. E 2–1

Safety

Safety Features..................................................................................... 2
Symbols and Warning Labels ............................................................ 3
Safety Guidelines................................................................................. 4

Printer Installation ................................................................................ 4
Printer Operation .................................................................................. 4
UV Radiation ......................................................................................... 4
Printer Maintenance ............................................................................. 4
Model and Support Materials ............................................................. 5

First Aid for Working with Printing Materials ............................... 6
Waste Disposal..................................................................................... 7



Safety

2–2  DOC-13000 Rev. E

Safety Features
Connex 3‐D printers are designed to comply with CE and FCC standards. 
They are equipped with the following safety features:

Cover interlock 
switch

The power supplied to the UV lamp and the 
motion motors is turned off when the cover is 
opened.
WARNING: Do not defeat (override) the 
interlock switch. Doing so could result in 
serious personal injury. If the interlock switch 
does not function correctly, do not use the 
printer, and contact your service provider.

Cover lock The cover is locked while the printer is 
working. It is released when the printer reverts 
to pause or stop mode.
WARNING: Do not defeat (override) the 
safety lock. Doing so could result in serious 
personal injury. If the safety lock does not 
function correctly, do not use the printer, and 
contact your service provider.

UV screen  The transparent section of the cover blocks 
harmful UV radiation, allowing the operator to 
view the model as it is being made.

Circuit breaker The power to the printer is turned off in case of 
electrical overcurrent. 
Note: The circuit breaker is only accessible to 
service personnel.

Grounded chassis The chassis of the printer is grounded, to 
prevent electrical shock.
Note: The power outlet must be properly 
grounded, in accordance with the local 
electric code, to provide this protection.

If the Connex 3-D printing system is not used as specified in this guide, the 
safety features may not provide adequate protection.
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Symbols and Warning Labels
This following table lists the warning labels located on or in Connex 
printers.

Warning 
Symbol

Meaning Location Comments

Hazard 
(general)

On the name plate 
on the back of the 
printer.

Read the instructions 
in this document 
before operating the 
printer.

Hot surface  On the print‐head 
block.

Risk of burns. Do not 
touch this surface 
after printing.

High voltage  Near the UV lamp 
connectors.
Near the power‐
supply enclosures.

Risk of electric shock.

Ultraviolet 
radiation

Near the UV lamps. Risk of injury from 
ultraviolet radiation.

Moving parts On the panel visible 
when you open the 
doors of the 
printing‐materials 
compartment.

Risk of injury from 
moving parts.
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Safety Guidelines
The following general guidelines, together with the instructions provided 
throughout this user guide, ensure user safety while operating and 
maintaining the Connex system. If the system is not operated as specified, 
the userʹs safety may be compromised!

Printer 
Installation

Installation and removal of the Connex printer should only be done by 
qualified service personnel. 
Connect the printer to the electric outlet using a power cord that is 
safety‐certified.
The electric outlet should be easily accessible, near the printer.
Never connect the power plug to an outlet that does not have a ground 
(earth) wire, and never disconnect the ground. Doing so may expose 
the operator to serious danger from electric shock.
Leave a minimum of 15 centimeters between ventilation openings and 
walls or other objects.

Printer 
Operation

The Connex printer should only be operated by persons trained by an 
Objet customer‐support representative.
All personnel operating or maintaining the Connex printer should 
know the location of first aid and emergency equipment and how to 
use it. Never block access to this equipment!
Keep fingers and other body parts clear of the printer cover when 
closing it.
Never attempt to open the main cover of the printer while it is working!
Never override the interlock safety switch!
If the interlock safety switch ever fails, do not use the printer. 
Several parts of the printer remain extremely hot even after it has 
stopped operating. Avoid touching the UV lamps and the print block.

UV Radiation The UV lamps used in the printer emit dangerous radiation. If the UV 
lamps remain on when the printer cover is open, do not stare directly at 
the UV light. Shut down the printer and call your Objet service 
provider.

Printer 
Maintenance

Service operations should be performed only by qualified personnel 
who have been instructed in relevant safety precautions.
Notify co‐workers and those who have access to the Connex system 
before beginning non‐routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety 
officer or to other appropriate authorities.
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Model and 
Support 
Materials

Model and support materials are made of chemical substances. Although 
precautions must be taken when handling these materials directly, all 
model and support materials used by the Connex system are handled in 
sealed cartridges. Normally, operators of the Connex printer should never 
be directly exposed to hazardous materials. In the unlikely event of a leak 
or spill, follow the instructions that are included with the printing‐material 
cartridge used.

Store cartridges of model and support materials indoors, in a dry area 
with adequate ventilation, between 16‐27 degrees Celsius (60‐81 
degrees Fahrenheit). Never expose them to flames, heat, sparks, or 
direct sunlight.
Keep model and support materials away from areas where food and 
drink are stored, prepared and consumed.
Uncured printing material is considered a hazardous substance, 
requiring certain precautions when directly handling it. To prevent skin 
irritation, wear neoprene or nitrile gloves. If there is any chance that 
model and support materials might splash into the eyes, wear safety 
goggles. Prolonged direct contact with printing materials can cause an 
allergic reaction.
When handling UV‐cured models that may not be completely cured on 
the surface, common latex gloves are adequate. 
To prevent respiratory irritation, ventilate areas where model and 
support materials are used. The ventilation system should totally 
replace the air at least 20 times per hour. 
Clean up model‐material and support‐material spills with disposable 
towels or other absorbent, non‐reusable material, such as sawdust or 
activated charcoal. Rinse the spill area with denatured or isopropyl 
alcohol (IPA), followed by soap and water. Dispose of the absorbent 
material in accordance with local regulations.
Do not wash contaminated clothing at home; clothing should be 
professionally laundered.
Dispose of contaminated shoes, belts and other leather items in 
accordance with any applicable regulations. Absorbed printing 
material may re‐expose the user when these items are worn.
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First Aid for Working with Printing Materials
In general, try to avoid direct contact with uncured printing material. If 
skin or eyes come into contact with it, wash the area immediately and 
thoroughly with water, and follow these first‐aid instructions.

Contact with 
Skin

If uncured printing material comes in contact with skin, wash the affected 
area immediately and thoroughly with soap and cool water, then remove 
contaminated clothing. Pay particular attention to flushing the hair, ears, 
nose and other parts of the body that are not easily cleaned. 

Use cool water to prevent skin pores from opening, so that the liquid 
material does not easily penetrate the skin. 
Do not use solvents to clean skin. 
If large areas of skin have been exposed, or if prolonged contact results 
in blisters, seek medical attention. In any case, if irritation persists, seek 
medical attention.
Avoid the accidental transfer of printing material from the hands to 
other areas of the body, especially to the eyes. 
If protective cream was used, do not reapply it until the skin has been 
completely cleansed.

Contact with 
Eyes

If uncured printing material comes in contact with the eyes, flush 
immediately with large amounts of water for 15 minutes and seek medical 
attention. 

Avoid sunlight, fluorescent light, and other sources of ultraviolet 
radiation.

The wearing of contact lenses when handling liquid printing materials is 
not recommended. If the liquid splashes into the eyes when contact lenses 
are worn, immediately remove the lenses and flush the eyes with water. 

Clean and disinfect the contaminated lenses.
Do not wear contact lenses until eye irritation disappears.

Ingestion If printing material is swallowed, refer to the instructions included with the 
cartridge. Seek medical attention immediately.

Inhalation Vapors from printing materials can be irritating to the respiratory system. 
If respiratory irritation occurs, expose the victim to fresh air immediately.

If the victim has stopped breathing, perform artificial respiration or 
cardiopulmonary resuscitation. 
Seek medical attention immediately.
Keep the patient warm but not hot. 
Never feed anything by mouth to an unconscious person.
Oxygen should be administered by authorized personnel only.
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Waste Disposal 
Fully cured printed models can be disposed of as ordinary office trash. 
However, special care is required when handling printer waste.

When removing the waste container from the Connex printer, wear 
neoprene or nitrile gloves.
To prevent liquid waste from splashing into the eyes, wear safety 
goggles.
Liquid waste from the Connex printer is classified as hazardous 
industrial waste. Therefore, printing‐material waste must be packaged 
and disposed of in a manner that prevents human contact with it and 
contamination of water sources.
Empty model‐material and support‐material cartridges contain residue 
of their contents. Some leakage of this residue may occur through the 
broken cartridge seal. Therefore, handle and store empty cartridges 
with care. 
Do not attempt to reuse empty cartridges, and do not puncture them.
Dispose of used cartridges and waste containers in accordance with 
local regulations.
Discard contaminated clothing, shoes, empty containers, etc., in 
accordance with any applicable regulations.
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Welcome to Connex
The advanced capabilities of the Connex 3‐D printing system are made 
possible by PolyJet Matrix™ technology, specially developed by Objet for 
printing models simultaneously with different model materials. For the 
first time, you can achieve the following results when printing 3‐D models:
• You can prepare models for printing with designated model materials 

and then print them—using two basic model materials loaded in the 
printer, or combinations of the two materials (digital materials). 

• Parts of the same model can be made—simultaneously—from different 
materials.

• Models made from digital materials can have unique physical 
properties, depending on the materials used.

• You can print objects that have a “coating” made from a different 
material than the main part of the object.

In addition, because Connex printers can be loaded with two different 
materials, and can print simultaneously with combinations of them, you 
can streamline and economize the process of producing models:
• You can print models made from different (single) materials on the 

same build tray (“mixed tray”), in the same print job. This eliminates 
the time‐consuming need and expense of loading another material, 
flushing the system, and sending a separate job to be printed.

• You can quickly alternate printing jobs with either of the two model 
materials loaded—or with material combinations—again, without the 
need and expense of replacing materials.

The Connex system also enables you to split models into component parts 
(“shells”) so you can isolate, manipulate and print parts of a model. 
However, you have ultimate control when separating models into shells by 
preparing stl files with your CAD software. Then, with Objet software, you 
can assign model materials and other characteristics to the shells.

Figure 3-1: The Connex500 3-D Printer
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Work Configurations
The Connex500/350 3‐D printing system can be set up as a single‐station 
system or as a multi‐station system. When connected to a local computer 
network, the system can serve multiple users. In such configurations, each 
user workstation (client) prepares files with Objet Studio software for 
production. A server (host), typically next to the 3‐D printer, acts as a job 
manager that sends production jobs to the printer for production. 
Figure 3‐2 shows the Connex printer set up in a multi‐client configuration.

Figure 3-2: Multi-client network configuration

When installing the Objet software, you choose whether to install it as a 
client station or as a master station (server or standalone station).
The Objet software arranges the jobs it receives according to their priorities, 
model‐material type, and other factors. In multi‐workstation 
configurations, the operator of the server—typically the production 
administrator—has total control over the jobs sent to the 3‐D printer, and 
can prioritize and delete jobs, review job history and reprint a job, and so 
on.

Connex server

Connex printer

KVM switch

Client 
workstations

Printer 
workstation
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Source Files 
Connex 3‐D printing systems produce three‐dimensional models designed 
with most 3‐D CAD tools and with other job‐specific 3‐D applications. 
Connex systems accept:
• STL Files
• SLC Files
Connex systems feature the capability of producing both types of model 
files simultaneously.

STL Files STL is short for Standard Triangulation Language. This language views any 
object as a collection of surfaces, and describes each surface of the object as 
a collection of triangles. 
For example, a square can be described as two triangles; a cube (six 
squares) as 12 triangles. Curved surfaces need more triangles to describe 
them. The higher the tolerance (for smooth surfaces), the more triangles are 
needed. The result is that high‐quality object descriptions mean very heavy 
files. 
Most CAD software can export STL files. The Connex system utilizes these 
files for building models (rapid prototyping), and also for directly making 
molds for mass‐producing items.
STL files are ASCII (text) files. The content of each file begins with “solid” 
and ends with “end‐solid” (both lower case). Between these keywords is a 
list of the triangles that describes the faces of the solid model. Each triangle 
defines a single normal vector directed away from the solid’s surface, 
followed by its X‐Y‐Z coordinates. These are expressed as Cartesian 
coordinates and are floating‐point values. The coordinates of all triangles 
should be positive and should fall within the volume of the model. 

SLC Files SLC is short for Stereo‐Lithography Contour. SLC files describe two‐
dimensional contours of the three‐dimensional models. These contour lines 
are polylines. 
SLC files are ASCII (text) files that save models as a series of slices. This 
means that models based on SLC files cannot be orientated; only their scale 
(size) and position on the build tray can be controlled. For this reason, the 
model’s orientation must be suitable for production before it is saved as an 
SLC file. Because of the nature of SLC files, the appearance of models in 
Objet Studio may be different than the solid‐object images displayed from 
STL files.
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Connex Workflows
With Connex 3‐D printing systems, you have great flexibility in preparing 
model files and printing them. Below are the major workflows that have 
been made possible by PolyJet Matrix technology on Connex systems. You 
can find detailed instructions for implementing the listed tasks in chapter 5 
(“Using Objet Studio”).

Connex workflows, from design to finished models

Stage Workflow A Workflow B Workflow C
CAD program • Design a 3‐D 

object.
• Save as a single stl 
file.

• Design a 3‐D 
object.

• Save the object as 
an assembly of stl 
files.

Objet Studio • Open (Insert) the 
stl file.

• Separate the object 
into its 
components 
(“shells”).

• Assign materials to 
the components.

• Open (Insert) the 
stl files as an 
assembly.

• Assign materials to 
the assembly’s 
components.

• Open (Import) an 
objdf file. (objdf files 
contain model‐
material 
information.)

• Save the object as an objdf file (optional).

• Save the build tray. / Send the build to the printer.
Connex 3‐D Printer

Models are produced in the printer.

WaterJet

• Remove the support material from the models.

Finished model

Finished model.
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Printing Materials
Connex printers produce models by jetting thin layers of printing materials 
on the build tray, until the complete model is formed. Two types of material 
are used in this process:
• Model material—which makes up the finished model
• Support material—which fills gaps and spaces in the model during 

printing, and is removed after printing

Storage Materials used for printing models with Connex printers are made of 
resins, which are composed of reactive monomers and oligomers. 
Although printing materials are supplied in sealed, UV‐proof cartridges, 
care must be taken when storing and handling them. Follow these 
guidelines to protect operators and the environment, and to ensure 
optimum results. 
• To ensure product stability, do not allow these materials to come into 

contact with metal. Plastics made from monomer‐soluble substances 
(such as polystyrene or polyvinyl chloride) are not suitable for storing 
Objet printing materials.

• When not in use, keep material cartridges tightly sealed to prevent 
contamination, the effects of exposure to UV radiation, and accidental 
spillage. 

• Store material cartridges indoors, in a dry area with adequate 
ventilation, between 16–27 degrees Celsius (60–81 degrees Fahrenheit). 
If exposed to heat or flames, cartridges may burst or ignite.

• Signs of premature polymerization in material cartridges may include 
bulging, leaking, the emission of heat, and unusual odor. Exposure to 
heat can cause resin to gel in the cartridge.

• Make sure that material cartridges are stored in accordance with all 
local regulations and other applicable requirements.

Shelf Life Materials used for producing models have a limited shelf life. The expiry 
date on the label is valid when properly stored in an undamaged, 
unopened cartridge. Always rotate your stock, so that the cartridge with 
the earliest date is used first.

Exposure to 
Light

If printing materials are not in their sealed cartridges, make sure to shield 
them from sunlight and other sources of UV radiation, such as fluorescent 
and mercury‐vapor lights. Exposure to UV radiation causes an increase in 
viscosity and, eventually, solidification.
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Safety 
Considerations

Before being cured, resins are hazardous materials. To prevent possible 
health hazards, follow these precautions regarding printing materials: 
• Do not expose to flames, heat or sparks.
• Prevent contact with skin and eyes.
• Ventilate areas where they are handled. 
• Keep them separate from food and drink.
Cured plastic parts, however, are safe. They can be handled and stored 
without precautions.

Disposal Dispose of cartridges of Objet model and support material in accordance 
with all applicable laws and regulations. If necessary, the cartridges can be 
disassembled for recycling. 

Work Environment
Extreme heat and humidity conditions can adversely affect the operation of 
the Connex 3‐D printer. Therefore, it is recommended that you use 
ventilation or air‐conditioning systems, if necessary, to keep the work area 
within the following ranges:
• 18°–22° C (64°–71° F)
• 30%–70% relative humidity

You can find more safety information about resins in “Safety Guidelines” on 
page 2-4, and “First Aid for Working with Printing Materials” on page 2-6.
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Workstation Requirements 
The minimum requirements for computer components used with Objet 3‐D 
printer software are listed in the following table.

* Also supported:
Windows 7 (32‐bit/64‐bit), Professional, Ultimate, Enterprise editions
Windows Vista (32‐bit/64‐bit) Ultimate, Business, Enterprise editions

Note: On 64-bit operating systems, Objet Studio runs as a 32-bit 
application.

Recommendations:
• Monitor resolution: 1280 x 1024 pixels
• Color quality: 32 bit
• Two Ethernet ports

Server/
Stand-alone Station

Client Workstation

Processor Pentium 4, 3.0 GHz, 
512 KB cache memory (min.)

Pentium 4, 3.0 GHz (min.)

Operating System* Windows XP Professional Windows XP Professional

Graphics Card Supporting open GL, 
with 512 MB of memory

Supporting open GL, 
with 512 MB of memory

RAM 4 GB (min.) 2 GB (min.)

CD Drive IDE CD ROM IDE CD ROM

Hard-Disk Drive 40 GB (min.) 40 GB (min.)

Network Adaptor 
Cards

LAN TCP/IP (2) LAN TCP/IP (1)

Ethernet Cables •Straight‐through cable (1)
•Crossover cable (1, supplied)

Straight‐through cable (1)
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Preparing Files for Use with Connex 3-D Printing Systems
Before using files with Connex 3‐D printing systems, you must convert 
them in your CAD program to either STL files or SLC files. (For an 
explanation of these file formats, see “Source Files” on page 3‐4.)
After converting the model files, it is recommended that you check them for 
defects in an STL‐repair application (such as Magics, by Materialise) before 
opening them in Objet Studio and producing the model.

Converting 
CAD Files to 
STL Format

This procedure may vary slightly, depending on the CAD software used, 
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.
2. In the Save As dialog box, open the Save As Type pull‐down menu and 

select *.STL.
3. Click Options and set the following parameters:

• Total Quality—approximately 0.1 mm (deviation tolerance / linear‐
dimension tolerance)

• Detail Quality—approximately 4° (angle tolerance)
Note: Lowering these values produces more accurate models, but 
results in larger files and longer loading and processing times. For this 
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and 
ASCII formats can be used in Objet Studio. However, binary files are 
smaller, so this option is recommended.)

5. Click OK or Save.

Converting 
Files to SLC 
Format

When converting files to SLC format, it is recommended that you set a layer 
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in 
Objet Studio, it is important that models are properly orientated before 
being saved as SLC files. Considerations for suitable model orientation are 
explained in “Model Orientation” on page 5‐18.
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Objet Studio Software
Objet Studio software for the Connex 3‐D printing system consists of two 
main sections:
• Objet Studio
• Job Manager

Objet Studio
With Objet Studio, you prepare source files for production in Connex 3‐D 
printers. Objet Studio offers you a wide variety of file‐preparation options, 
but always consists of the following basic procedure:
1. Inserting one or more objects on the build tray
2. Positioning the object(s) on the tray
3. Configuring object and tray parameters
4. Saving the tray configuration as an objtf (Objet Tray Format) file
5. Sending the objtf file to the Connex 3‐D printer for production
Using Objet Studio to perform these tasks is described in detail in chapter 5, 
“Using Objet Studio.”

Job Manager
Job Manager is different for client workstations and for the computer 
connected directly to the Connex 3‐D printer. 
• In Objet Studio installed on the directly‐connected computer (server), 

Job Manager displays the queue and status for all jobs sent to the 3‐D 
printer by the client computers on the network, and allows editing and 
manipulation of all jobs. 

• In Objet Studio installed on client computers, Job Manager displays the 
queue and status only for jobs sent to the 3‐D printer server from that 
computer, and allows the user to edit only these jobs.

Client computers can be connected, via the local network, to different 
Connex 3-D printers, but only to one at a time. The client Job Manager 
displays the status of the 3-D printer to which the client is currently 
connected.
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How to Install Software for the Connex 3-D Printing System
The Objet Studio setup wizard guides you when installing the Objet 
software. During installation, you must choose to install either the server 
(“host”) application or the client application. 

To install Objet software:
1. Insert the Objet Studio CD into the disk drive.
2. Right‐click the Start button and select Explore (or use any other method 

for displaying files on the computer).
3. Open the CD‐drive folder and select Setup.

To run the installation wizard, you must accept the Objet Studio license 
agreement. After reading its terms, click Yes to continue, or No to close 
the wizard.
If you click Yes, the following screen should appear. 

Figure 4-1:Objet Setup—installation wizard Welcome screen
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4. Click Next to begin installation.

Figure 4-2: Objet Setup—Select Components screen

5. When the Select Components screen appears, select one of the 
installation options, then click Next.
• Select Objet Studio only for client workstations
• Select Objet Studio and Job Manager for the server (host) station and 

for a standalone station—that is, the computer directly connected to 
the Connex printer.

Figure 4-3: Objet Setup—Choose Destination Location screen

6. In the Choose Destination Location screen, verify the destination folder 
and click Next. 

It is recommended that you do not change the default destination folder.
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Figure 4-4: Objet Setup—Select Program Folder screen

7. In the Select Program Folder screen, verify the pre‐selected folder in 
which the Objet Studio icons will be installed. 
• To install the icons in another program folder, select it. 
• To continue, click Next.
Installation begins and the Setup Status screen appears, showing the 
progress of the installation process.

Figure 4-5: Objet Setup—Setup Status screen
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When the Objet program installation is complete, the final InstallShield 
Wizard screen appears.

Figure 4-6: Objet Setup—final wizard screen

To complete the software installation, you must restart the computer. 
You can do so now or at another time. 

8. Select either “Yes…” or “No…” and click Finish.
Make sure to remove the CD from the disk drive before restarting the 
computer.

The installation process ends when the appropriate icon(s) appear on the 
computer desktop: 
• Objet Studio
• Job Manager (for servers and standalone stations)
• Stop Job Manager (for servers and standalone stations)
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Opening Objet Studio
After you install Objet Studio, a launch icon   appears on the 
Windows desktop. Open the application by double‐clicking this icon, or by 
selecting Objet Studio from the Start > Programs menu.
Objet Studio opens, displaying an empty build tray.

Figure 5-1: Objet Studio opening screen

Toolbars The icons shown in this chapter are available only when relevant toolbars 
are displayed. You can control the toolbars displayed at any time, and you 
can re‐arrange them on the screen.

To customize the toolbars displayed in Objet Studio:
1. From the View menu, select Toolbars.
2. In the Customize dialog box, select the toolbars you wish to display, and 

click OK.

Figure 5-2: Toolbar selection dialog box

3. Click and drag the toolbars to position them as you wish on the Objet 
Studio screen.
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Preparing Models for Production
Just as Connex printers can produce different models on the build tray 
using different materials, you can produce components of models with 
different materials. To do this, each part of the model must be a separate stl 
file. If the model’s component parts were not saved in the CAD software as 
separate stl files, you can use Objet Studio to separate the model into 
component parts. (This is described in “Splitting Objects into Components” 
on page 8 and in “Dividing Objects” on page 39.)

OBJDF Files: 
Overview

An objdf file describes both the geometry of a single object and the materials 
required to print it. The objdf file can represent an object that is a single stl 
file, or an object assembled from component stl files. 
Objet Studio enables you to split an stl file representing a complex object 
into an assembly of component stl files, and save the assembly as an objdf 
file. Each part (stl file) described by the objdf file can have its own model‐
material characteristic, so that the Connex printer produces the component 
parts from specific materials. 
Another use for objdf files is for saving a group of separate objects on the 
build tray as one unit, together with their relative positions and materials. 
This is especially useful for producing models in the future with the same 
materials. In fact, when you save objdf files, you specify materials for 
printing models without regard to the material cartridges loaded in the 
Connex printer. The same object can later be placed on build trays for 
printing. Each time you send a build tray to the printer, you decide whether 
to allow printing with substitute materials or only with the materials 
specified.
The Connex version of Objet Studio enables you to display, manipulate and 
print component parts of a model assembly that was saved as an objdf file, 
since each component is a separate stl file. This can be useful for printing 
only specific parts of a model.
Further explanations of objdf files and assemblies, and instructions for 
utilizing their features, appear throughout this chapter.

Opening 
Model Files

To produce models, you must open one or more files in Objet Studio and 
position the objects on the build tray. You can place objects on the build tray 
in several ways:
• by inserting individual stl or slc files (or an assembly of stl files)
• by importing an objdf file (an assembly)
• by pasting objects that you copied to the Windows clipboard

Opening STL 
& SLC Files

To place an object on the build tray using stl or slc files:
1. Open the Insert dialog box—

• From the Object menu, select Insert.
or—
• On the toolbar, click the Insert Model icon  .
or—
• Right‐click on the build tray, and select Insert.
The Insert dialog box appears.
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Figure 5-3: Insert dialog box

2. In the Look in field, display the appropriate folder.
3. In the Files of type field, select the file types to display (stl, slc).
4. Select the desired file, and make sure that it appears in the File name 

field.
If the Preview check box is selected, the object is displayed in the dialog 
box, as shown in figure 5‐3.
Note: You can open several stl files at once, to place several models on 
the build tray. If you select multiple stl files that make up an assembly, you 
can select all or some of the parts. To print the entire model, select all of an 
assembly’s component stl files, and select the Assembly check box. This 
inserts the parts as a complete, integrated model instead of as independent 
parts. To see the effects of selecting the Assembly check box—in both the 
hierarchy pane and the build tray display—see the following figures.

Figure 5-4: Assembly check box selected—stl files are inserted as assembly

Figure 5-5: Assembly check box not selected—stl files are inserted as parts
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5. Select any of the following options, as required:
• Units—Choose millimeters or inches for the object’s units of measure.
• Number of copies—Choose how many copies of this object to place 

on the build tray.
• Arrange models—Select this check box to automatically position 

objects on the build tray for efficient model building.
• Assembly—Select this check box if you selected multiple stl files that 

are parts of an assembly.
Note: The 3-D file contains the object's proportions, but not its units of 
measure. Therefore, make sure to correctly select either millimeters or 
inches when inserting an object. Otherwise, the size of the object on the 
build tray will be either much too large or much too small. 

6. Click Open.
Objet Studio places the object(s) on the build tray, and in the list in the 
hierarchy pane.

Figure 5-6: Default screen layout

You can place additional objects on the build tray by repeating this 
procedure.

Opening Objet 
Digital Files

To place an object saved as an Objet Digital Format file (.objdf or .odf) 
on the build tray:
• From the Object menu, select Import OBJDF File.
or—
• Right‐click on the build tray, and select Import OBJDF File from the 

context menu.
The Open dialog box is displayed.

The Extents values displayed at the bottom of the dialog box represent the 
maximum dimensions of the object on each axis. These dimensions 
correspond to the virtual “bounding box” surrounding the object (see 
figure 5-43 on page 27).

Hierarchy 
pane

Build tray

Object 
properties
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Figure 5-7: Objet Digital File import dialog box

7. In the Look in field, display the appropriate folder.
8. Select the desired file, and make sure that it appears in the File name 

field. 
If the Preview check box is selected, the object is displayed.
The Materials box displays the models material(s) defined for the object.

9. Click Open.
The following dialog box opens.

Figure 5-8: Objet Digital File Folder dialog box

Before placing the object on the build tray, Objet Studio must extract 
additional information regarding the materials and the position of the 
object and its parts. To do this, Objet Studio creates a folder with the 
same name as the objdf file. By default, this folder is created in the same 
location as the objdf file, but you can select another location.

10. Click OK.
Objet Studio places the object on the build tray and lists it in the 
hierarchy pane as an assembly together with its components.

You can place additional objects on the build tray by repeating this 
procedure.
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Copying and 
Pasting 
Objects

If you need to duplicate objects on the build tray, you can, of course, insert 
the same object from its file more than once. An easier way, however, is to 
copy and paste the object. You can copy objects from the build tray or the 
hierarchy pane—individual or multiple parts or assemblies. The objects 
copied remain in the Windows clipboard until you paste them onto the 
build tray. 
You can also copy objects from one tray and paste them onto another, in the 
same way as you copy text from one document and paste it into another 
one. However, Objet Studio allows only one tray to be open at a time. For 
each build tray you need to work with (at the same time), you must open a 
separate Objet Studio window, by running the application again (from the 
Windows Start menu).

You perform the Copy and Paste commands as in other Windows 
applications:
• from the Edit menu, on the main toolbar
• from the right‐click context menu
• by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively)
The Paste Special command (in the Edit menu) enables you to place 
duplicate objects even more efficiently:
• You can specify the number of duplicates to place on the build tray at 

once.
• You can set the distance, on each axis, between the duplicate objects.
• You can place mirror images of the original object.

Figure 5-9: Paste Special dialog box

Because objdf files contain information about model materials, a warning 
message appears if the object you wish to place on the build tray is defined 
with materials not supported by your system, or if an object already on the 
build tray uses different materials. (If this happens, see “Model-Material 
Settings” on page 9 for printing options.)

Having multiple Objet Studio windows open can be convenient when you 
need to manipulate or configure objects before inserting them in your 
production build tray. For example, if you need to change the model material 
of an object (saved as an objdf file) to match the model material already 
used in the production build tray, you must do so before inserting the 
object—on another tray. Copying and pasting also allows you to utilize 
objects already configured on previously-used build trays for newer 
projects.
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Selecting 
Objects

To manipulate an object on the build tray or assign characteristics to it 
(model material, surface finish, etc.), you must first select the object. You 
select an object by clicking it, either on the tray or in the tray hierarchy 
pane. Its image on the build tray changes color (to light blue, by default) 
and its name is highlighted in the tray hierarchy pane. You can select 
multiple objects by pressing the Ctrl or Shift keys while clicking additional 
objects.
Sometimes, you need to select individual elements of an assembly. Other 
times, you need to select the entire assembly. To choose which will be 
selected when you click on the model, first click the appropriate icon on the 
toolbar:

Figure 5-10: Select Group and Select Element icons 

Note: When selecting one element of an assembly from the hierarchy 
pane, the Select Element icon is automatically activated.

Splitting 
Objects into 
Components

You can convert a complex object to an assembly of component parts. To do 
so, you split the stl file that represents the object into an group of separate 
stl files, each one representing a component. (This is referred to in the Objet 
Studio interface as separating the object into shells.) You can then assign a 
model material to each stl file, and you can save the newly‐created 
assembly as an objdf file.

To convert an object to an assembly of component parts:
1. If the object is not displayed, place it on the build tray by inserting its stl 

file (see “Opening STL & SLC Files” on page 3).
The object appears—on the build tray and in the hierarchy pane—as a 
single part. It is assigned, by default, the “primary” model material. (If 
Objet Studio is configured with a secondary material, you can assign 
it—or a digital material—to the entire object. This is explained in 
“Model‐Material Settings” on page 9.)

Figure 5-11: Object placed on the build tray from a single stl file

Note: There is no need to resize or arrange the object on the build tray at 
this time.

2. With the object selected, do either of the following:
• From the Object menu, select Separate into Shells.
or—
• On the toolbar, click the Separate into Shells icon  .
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A dialog box opens in which you can specify where to save the 
component stl files. (By default, Objet Studio offers to save the new files 
in a folder in the same location as the original stl file.)

Figure 5-12: Folder selection for saving stl files after splitting into shells

3. Click OK.
Objet Studio splits the object into an assembly of component parts, each 
a separate stl file (“shell”).
The object appears—on the build tray and in the hierarchy pane—as an 
assembly of parts (“shells”). You can assign each part a different model 
material (This is explained in “Model‐Material Settings” on page 9). 

Figure 5-13: Object after being converted to an assembly of component parts

Model-Material 
Settings

Before placing objects on the build tray in Objet Studio, you should pay 
attention to the model‐material settings in the toolbar.

Figure 5-14: Model-material-settings toolbar

• By default, the model‐material settings in the Objet Studio toolbar 
correspond to the two model cartridges loaded in the Connex printer.

• The material displayed on the right (VeroWhite, in the figure above) is 
considered the primary model material (“Model‐1”). It is assigned to 
objects that do not have a material assignment when you place them on 
the build tray. For example, since stl files do not contain information 
about the model material, Objet Studio assigns the primary model 
material to them. Also, if you try to import objdf files whose assigned 
materials are not recognized by your version of Objet Studio, you can 
open the file by substituting the primary model material for the missing 
materials.

• If you import an objdf file to an empty build tray, and the model‐
material assignment does not match the settings in the model‐material 
toolbar, the toolbar settings are changed automatically. However, if 
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there is an object already on the build tray whose materials don’t match 
the material assignment in the objdf file, you cannot place the new object 
on the tray. To print this object, you have the following options:

Instead of printing it on the same build tray, print the new object as a 
separate job.
Change the materials assigned to objects on the build tray to match 
those assigned to the new object (see “Changing the 
Model Material” and “Assigning a Model Material to Objects,” 
below).
Change the materials assigned to the new object before importing it, 
so there is no conflict with the settings in the model‐material toolbar.

To change the materials assigned to an object before importing it:
1. Open another Objet Studio window, by running the application from 

the Windows Start menu.
2. Import the new object (objdf file) to the empty build tray.
3. Change the model‐material settings in the toolbar to those used on the 

other build tray.
4. Assign materials to the object (see “Assigning a Model Material to 

Objects” on page 11).
5. Select the object and copy it.
6. Display the other Objet Studio window, and paste the object onto the 

build tray.

Note: You can save the object with the new materials either as a new objdf 
file, or by saving the original file with the changes.

Changing the
Model Material

When you design a build tray in Objet Studio, you can use model materials 
that may not be currently installed in the Connex printer. Because the 
installed materials are displayed by default, change the model‐material 
settings in the toolbar (from the drop‐down menus), if necessary.

Figure 5-15: Configuring the model material to be used with the current build tray

Digital 
Materials

When two different model materials appear in the toolbar, you can produce 
objects from either material or from a combination of them—digital 
materials. Different pairs of model materials enable you to print objects 
using unique digital materials. Certain digital materials can produce 
objects with different shades of color. Combinations of model materials 
that have different mechanical properties result in digital materials with 
unique characteristics.

When you send the job to the print queue, you indicate whether or not you 
allow substitute materials to be used—see “Model Material Substitution” on 
page 37.
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To view the digital materials available for printing objects (using two 
basic model materials):
1. Make sure that you have selected the appropriate model materials in 

Objet Studio.

Figure 5-16: Model-material-settings toolbar, showing two basic model materials

2. Click the Material Selection Guide icon  .
A screen is displayed, showing the basic model materials (at the top of 
the list) and the digital materials available (combinations of them).

Figure 5-17: Material Selection Guide, showing the digital materials 
available with the two basic model materials

Assigning a 
Model Material 
to Objects

You can assign any of the available digital materials to objects on the build 
tray. 

To assign a model material to objects:
1. Select an object on the build tray (see “Selecting Objects” on page 8).

When an object is selected, its properties are displayed in the object 
properties dialog box (in the Options tab).

Figure 5-18: Object properties, Options tab
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2. In the Material Selection section, display the pull‐down menu and 
select the desired material.

 
Figure 5-19: Menu for assigning materials to objects

When you de‐select the object on the build tray, it is displayed, by 
default, with the color of the material you selected. In the same way, 
you can assign model materials to each of the independent objects on 
the build tray.
Note: If the model-material color is not displayed, click the object-color-
display switch.

Figure 5-20: Object-color-display switch

Coating 
Objects

You can print composite models where the surface layer is a different 
material than the inside. This can be useful to achieve unique mechanical 
and textural characteristics. This technique is called “coating.” 

To coat an object with a different model material:
1. Select an object on the build tray.
2. In the object properties dialog box (see figure 5‐18), click 

The Coat with dialog box opens.
3. Select Coat with and, from the pull‐down menu, select the coating 

material.

Figure 5-21: Coating material selected

To separate an object into independent, component parts (each an stl file), 
see “Splitting Objects into Components” on page 8.
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4. In the Thickness field, enter the coating thickness, in millimeters, 
between 0.3 and 3.
Note: The coating thickness does not affect the external dimensions of the 
object, which remains unchanged. The coating layer replaces part of the 
main model material.

5. Click Apply.
In the object properties dialog box, Coating is selected.
Note: When you de-select objects, they are displayed, by default, with 
colors representing the model-material. Even after adding a coating to an 
object, its color remains that of the main material, not the color of the 
coating material.

To inspect, modify or remove the coating applied to an object:
1. In the object properties dialog box, click 

The Coat with dialog box opens.
2. Perform one of the following actions—

• Change the coating settings, and click Apply.
• To remove the coating, clear the Coat by check box and click Apply.
• To keep the current coating settings, click Apply or Cancel.

Assigning 
Properties to 
Hidden 
Objects

To enable you to assign materials and other properties to parts of objects 
that are hidden from view in the build‐tray display, you can temporarily 
turn off the display of some objects. 

To prevent the display of objects:
1. Right‐click an object, either on the build tray or in the hierarchy pane.
2. From the menu that opens, select one of the following options—

• Hide, to cause the selected object to disappear
• Hide Others, to cause all other objects on the build tray to disappear, 

so that only the selected object is displayed
Alternately, you can clear the check box next to the name of the object in the 
hierarchy pane to cause that object to disappear.

Figure 5-22: All objects shown Figure 5-23: Outer object hidden
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Arranging the Objet Studio Screen
The default screen layout displays the perspective view of the build tray and 
the tray hierarchy pane, which lists the elements placed on the tray (see 
figure 5‐6 on page 5). You can view models from different angles by 
changing the screen layout.

To change the Objet Studio screen layout:
From the View menu, select Layout, then the desired number of build‐
tray views.

2 Views is the default screen layout, already displayed (see figure 5‐6 
on page 5).
By default, the object properties dialog box is also displayed.
3 Views adds top and front views to the default screen layout (see 
figure 5‐25, below).
4 Views displays top, front and right views (see figure 5‐26).
1 View expands the perspective view to fill the screen (see figure 5‐27).

You can also change the screen layout with toolbar icons.

Figure 5-24: Screen layout icons

Figure 5-25: 3-view screen layout
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Figure 5-26: 4-view screen layout

Figure 5-27: 1-view screen layout

You can change the perspective of the active viewing pane by clicking any 
of the nine viewing icons.

Figure 5-28: Viewing-pane perspective icons
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Positioning Objects on the Build Tray
To produce models efficiently and with the required finish, it is important 
to carefully position objects on the build tray. Objet Studio features the 
automatic positioning of objects. However, you should check to make sure 
that the objects are orientated logically for your needs, according the 
considerations explained in “Model Orientation” on page 5‐18.

Automatic 
Positioning

There are two ways to have Objet Studio position the items on the build 
tray.
• Anytime you insert an object onto the build tray, select Arrange models 

in the Insert dialog box.

Figure 5-29: Arrange models option in the Insert dialog box

When you click Open, Objet Studio inserts the new object and arranges 
all of the objects on the build tray.

• After placing several objects on the build tray, select Tools > Automatic 
Placement.

The effects of automatic placement are shown in figures 5‐30 and 5‐31.
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Figure 5-30: Tray before objects are properly arranged

Figure 5-31: Tray after objects have been automatically arranged

Manual 
Positioning

You can manually position objects on the build tray—even if they were 
inserted using automatic placement (with the Arrange models option 
selected in the Insert dialog box). Considerations for positioning objects are 
reviewed in “Model Orientation” on page 5‐18. Tools for changing the 
position of objects are described in “Repositioning Objects” on page 5‐20.

Because of the unique characteristics of each type of modeling material, it 
is recommended that you select the material before inserting objects on the 
tray with automatic positioning or running Automatic Placement.
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Model Orientation
The orientation of models on the build tray affects how quickly and 
efficiently they will be produced by the 3‐D printer, where and how much 
support material is used, and whether or not model parts will have a gloss 
finish. Therefore, you should consider a variety of factors when deciding 
how to place models on the tray, using the following positioning rules. 

X-Y-Z Rule
This rule considers a modelʹs outer dimensions.

Since the print heads move back and forth along the X‐axis, the printing 
time along this axis is relatively short, compared to printing time along 
the Y‐axis and Z‐axis. From this point of view, it is advisable to place the 
objectʹs longest dimension along the X‐axis.
Since high‐resolution models are built up, on the Z‐axis, in 16‐micron 
layers, it is very time‐consuming to print a tall object. From this point of 
view, it is advisable to place the objectʹs smallest dimension along the Z‐
axis.
Since the print heads measure about 2 inches (5 centimeters) on the Y‐
axis, models measuring less than this (on the Y‐axis) are printed in one 
pass. From this point of view, it is advisable to place the objectʹs 
intermediate dimension along the Y‐axis.

Tall-Left Rule
This rule considers models where, after being orientated on the build tray 
according to other considerations, one side is taller than the other.

Since the print heads move along the X‐axis from left to right, taller 
sections on the right require the print heads to scan unnecessarily from 
the left until reaching them. If, on the other hand, the taller sections are 
positioned on the left of the tray, the print heads only have to scan the 
model until printing these sections—once the lower parts have been 
completed. Therefore, you should position the taller side of the model, 
when possible, on the left.

Recess-Up Rule
This rule considers models containing surface recesses.

Recesses in the surface (like hollows, drill holes, etc.) should, when 
possible, be positioned face‐up.

Fine-Surface Rule
This rule considers models that have one side on which there are fine 
details (like the keypad side of a telephone).

The side of the model containing fine details should, when possible, be 
positioned face‐up. This results in a smooth finish.

The following rules are based on the fact that support material is not 
required on the top of the printed model.
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Avoid Support-Material Rule
This rule considers models that have large holes or hollows, open on at 
least one side (like a pipe or a container).

It may be advantageous to print a model standing up, so support 
material does not fill the hollow, even though printing the model lying 
down would be much faster.

Manipulating Objects on the Build Tray
Object Position 
on the Z-Axis

When you use automatic positioning to arrange objects on the build tray 
(see “Automatic Positioning” on page 5‐16), the objects are positioned 
directly on the tray. If you do not insert objects with automatic positioning, 
they often appear either above or below the tray.

To position objects directly on the tray: 
1. Select the object.
2. Click the Lay On icon  .

or—
From the Object menu, select Lay On.

To ensure that objects are always directly positioned on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-32: Options dialog box, Settings tab

2. In the Automatic Lay On (Gravity) section, select Always. (This is the 
default setting.)

In practice, the Connex system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects 
directly on the build tray with Objet Studio is to correctly display the objects 
on the screen.
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Other Z-axis options (in the Automatic Lay On section):
• When under the tray—The display of objects that are below the build 

tray is automatically changed so that the object is at tray level.
• Never—The display of objects that are above or below the build tray is 

not changed.

Repositioning 
Objects

You can select and manipulate objects on the build tray after selecting the 
following icons or menu options.

After using these repositioning icons once, they are disabled, unless you 
first click the Sticky Mode icon  . After clicking this icon, the repositioning 
icon used remains active until you click the Sticky Mode icon again to 
release it.
Another way of repositioning objects on the build tray is by using the icons 
on the Transform toolbar that nudge the selected object in different ways. 

Viewing Object Properties
After you manually manipulate an object with the mouse, its new 
properties are displayed in the Transform tab of the object properties dialog 
box. 

Icon Menu 
Option

Purpose What to do

(none) For selecting an object. Click the object on the build tray.

Object > 
Translate

For selecting and moving 
an object with the mouse.

Click the object to select it.
Drag the object to a new location 
while holding down the mouse 
button.

Object > 
Rotate

For selecting and rotating 
an object on the Z‐axis.

Click the object to select it.
Hold down the left mouse button 
and move the mouse left/right.

Object > 
Scale

For selecting and 
changing the size an 
object.

Click the object to select it.
Hold down the left mouse button 
and move the mouse left/right.

Click to move the object 20 mm along the X‐axis.

Click to move the object 20 mm along the Y‐axis.

Click to move the object 30 degrees on the Z‐axis.

Click to rotate the object 30 degrees on the X‐axis.

Click to rotate the object 30 degrees on the Y‐axis.

Click to rotate the object 30 degrees on the Z‐axis.

The object-properties dialog box is displayed by default (see figure 5-6 on 
page 5) and whenever the screen layout is changed or refreshed (see 
“Arranging the Objet Studio Screen” on page 5-14).
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Figure 5-33: Object properties dialog box, Transform tab

You can make precise changes to an object on the build tray by selecting the 
object (either on the tray or in the tray hierarchy pane), changing its values 
in the dialog box, and clicking Change Units.

Note: You can only change the height of the objects on the build tray if this 
is allowed by the Objet Studio settings (see “Object Position on the 
Z-Axis” on page 5-19.)

The properties displayed in the Transform tab of the object properties dialog 
box are absolute values, representing the actual position of the object on the 
build tray. Another way of repositioning objects on the tray using precise 
values is by applying changes to object properties relative to the current 
position. There are two Relative Transform dialog boxes available: 
• The R. Trans tab of the object properties dialog box.

Figure 5-34: Object properties dialog box, R. Trans tab

• The Relative Transform dialog box, accessible from the Object menu.

Figure 5-35: Relative Transform dialog box
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Valid Object 
Placement 

To ensure that models do not overlap when you position them on the build 
tray, you can select the Dynamic Checking icon   from the Tools toolbar. 
When selected, Objet Studio only allows the positioning of objects if they 
do not interfere with other objects on the tray. Note that the space occupied 
by an object includes the “bounding box” surrounding it (see figure 5‐43 on 
page 27). 

Note: Because of the unique characteristics of each type of modeling 
material, it is recommended that you select the material before 
precisely positioning objects on the tray.

Grouping and 
Ungrouping 
Objects

You can manipulate two or more objects on the build tray, at the same time.
• Selecting multiple objects

Manipulating done to one object affects all selected objects. For 
example, turning one object on its axis causes all selected objects to turn 
on their respective axes.

• Converting the objects to an assembly
Separate objects become parts of one unit. For example, turning the 
assembly on its axis causes the whole assembly to turn as one unit.

To convert objects to an assembly:
1. Select the objects (see “Selecting Objects” on page 5‐8).
2. Click the Group to Assembly icon  .

or—
From the Object menu, select Group to Assembly.
In the tray hierarchy pane, the objects now appear under “Assembly.” 

Figure 5-36: Assembly in the tray hierarchy pane

After creating an assembly, you can save it as an objdf file, for re‐use. 
(Saving the assembly is not necessary for manipulating and printing it).

Even if you do not use Dynamic Checking when placing objects on the build 
tray, Objet Studio automatically checks if there is a problem with the 
positioning of objects on the tray before sending it to the printer. You can 
also manually check for problems after positioning objects (see “Tray 
Validation” on page 32).

The tray hierarchy pane does not display the assembly file name unless you 
import it as an objdf file.
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To save an assembly:
1. Select the assembly, (either on the build tray or in the tray hierarchy 

pane).
2. From the Object menu, select Export as OBJDF File...
3. In the Save As dialog box, choose a location, name the file, and click 

Save.

To separate assemblies into individual objects (stl files):
1. Select the assembly (either on the build tray or in the tray hierarchy 

pane).
2. Click the Ungroup icon  .

or—
From the Object menu, select Ungroup.
In the tray hierarchy pane, the elements now appear as separate objects.

Figure 5-37: Objects in the tray hierarchy pane

Using a Grid to 
Position 
Objects

Displaying a grid on the image of the build tray can be useful when 
positioning objects. You can make use of this feature by clicking the grid 
toolbar icons or by selecting menu options. 

You can review and configure grid settings—and apply them—from the 
Options dialog box.

To use the Options dialog box:
1. From the Tools menu, select Options, and display the Grid tab.

Icon Menu Option Result

Tools > Grid Displays a grid over all build tray views.

Tools > Snap to grid When moving the object, it aligns with the 
nearest grid line.

Enables you to change the grid origin 
(X‐ and Y‐axis meeting point) by clicking 
on the build tray.

Cancels the changes made to the grid 
origin and restores the default grid.
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Figure 5-38: Options dialog box, Grid tab, showing the default settings

The dialog box displays the current grid settings.
2. As required, make changes to the settings, and select or clear the check 

boxes.
3. Click Apply or OK.

Changing an 
Object’s 
Orientation

There are several methods for changing the orientation of objects on the 
build tray.

To rotate an object:
Select the object and use the Rotate icon or Object menu options (see 
“Repositioning Objects” on page 5‐20).

To select an object’s plane and re-align it with one of six basic directions:
• From the Plane Alignment toolbar:

1. Click the Select Plane icon  .
2. Click a plane on an object displayed on the build tray.
3. Click the appropriate align icon—

• From the Tools menu:
1. Select Plane Alignment > Select Plane.
2. Click a plane on an object displayed on the build tray.

Align Bottom

Align Top

Align Front

Align Back

Align Left

Align Right
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3. Select Plane Alignment > Align Bottom/Top/Front/Back/Left/Right (as 
appropriate).

Note: When you are finished re-aligning the plane of objects on the build 
tray, release the Select Plane icon or clear “Select Plane” from the 
Tools > Plane Alignment menu.

To flip an object 180 degrees on any axis:
1. Select the object.
2. From the Object menu, select Flip > Flip X / Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:
1. Select the object. 
2. Display the Transform tab or the R. Trans. tab of the object properties 

dialog box (see figure 5‐33 on page 21 and figure 5‐34 on page 21).
or—
From the Object menu, select Relative Transform (see figure 5‐35 on 
page 21).

3. Change the Rotate values for the desired axis.

Freezing an 
Object’s 
Orientation

If you manipulate an object on the build tray, you can freeze its orientation 
so that it does not change when you perform Automatic Placement (see 
“Automatic Positioning” on page 5‐16).

To freeze an object’s orientation:
1. Select a model on the build tray.
2. In the Options tab of the object properties dialog box, click Advanced.

The Advanced Properties dialog box opens.

Figure 5-39: Advanced Properties dialog box

3. Select the Lock Orientation check box.
4. Close the Advanced Properties dialog box.

Surface Finish Models can be produced with a matte or glossy finish. To create a matte 
finish, the printer surrounds models with a thin layer of support material. 
Models produced with a glossy finish are printed with a resolution of 300 
dpi (dots per inch) along the Y‐axis, instead of the standard 600 dpi 
resolution. 

Note: You can print a tray that contains models having both glossy and 
matte finishes. However, they will all be printed with a Y-axis 
resolution of 300 dpi.
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To choose the finish type for a model:
1. Select the model.
2. In the Options tab of the object properties dialog box, select Matte or 

Glossy.
or—
1. Right‐click the model on the build tray.

At the bottom of the context menu, the current finish type is not enabled 
(that is, you cannot select it).

2. To change the finish type, select the other (enabled) option.
You can distinguish between the finish of objects on the build tray by their 
color. When they are not selected, objects are displayed in a different shade 
of green for each finish. Because objects can also be displayed with the 
colors of the model material, a toolbar icon enables you to switch between 
the object color display, as follows:
A. Objects are displayed with the model‐material color.
B. Objects are displayed with colors to indicate the finish (matte/glossy).

Figure 5-40: Object-color-display switch

Display Options
From the View menu, you can change the way objects are displayed on the 
screen. The default method for displaying models on the build tray is as 
solid (“shaded”) objects. 

Figure 5-41: Tray and model displayed in shaded view

The other display options are wire frame and points.
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To display the build tray in wire frame view:
Select View > WireFrame or click the WireFrame icon  .

Figure 5-42: Tray and model displayed in Wire frame view

To revert to the shaded view:
Select View > Shaded or click the Shaded icon  .

To display objects as boxes, showing their maximum dimensions 
instead of the model geometry:

Select View > Display Bounding Box.

Figure 5-43: Model displayed with bounding box

To display the area around objects needed for support material (to 
produce a matte finish):

Select View > Display Thickening Box.

Figure 5-44: Model displayed with thickening box
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Display Colors You can customize some of the colors used for displaying Objet Studio 
screens and for displaying objects on the build tray.

To change the colors displayed in Objet Studio screens:
1. From the Tools menu, select Define Colors.
2. In the Define Colors dialog box, click the color patch you want to 

change:
• Tray Color—to change the color of the build tray
• Background Color—to change the background color
• Selection Color—to change the color of objects that are selected

Figure 5-45: Define Colors dialog box

3. In the Colors dialog box, select a color, or click Define Custom Colors to 
create your own color and shade for displaying this item.

4. Click OK.
The color of objects on the build tray—when they are not selected—can 
indicate either the color of the model material or the surface finish (matte or 
glossy) of the printed model. 

To set the color indication of objects displayed on the build tray:
1. In the Define Colors dialog box, select one of the options.

• Show color according to material.
• Show color according to building style.

2. Click OK.
Note: This selection has the same effect as toggling the object-color-
display switch.

Figure 5-46: Object-color-display switch

Before sending a build tray to the printer, or when you perform tray 
validation, Objet Studio checks if there is a problem with the stl files or the 
positioning of objects on the tray. If so, the affected objects are displayed 
with special colors (see “Tray Validation” on page 5-32). 
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Displaying 
Large Files

Very large stl files can be slow to display and may be difficult to manipulate 
easily on the build tray. If this is the case, you can display just an image of 
the object on the build tray without loading the entire file. The stl file itself 
is not changed, and the complete file is sent to the printer.

To display an image of stl files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.

Figure 5-47: Options dialog box, Settings tab

2. In the Large Files section, select Load Partial. (Load Full is the default 
setting.)
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Tray Viewing 
Options

The Objet Studio toolbars contain several icons for changing the 
appearance of the display screen, enabling you to view the tray and objects 
in different magnifications and from various perspectives.

Note: You must display the relevant toolbar(s) to access many of the icons 
described below (see “Toolbars” on page 5-2).

Icon Tool Tip Name Purpose

Zoom Full Reverts to normal view after using various 
zoom options. (The same as  .)

Zoom Object  Fills the viewing pane with the selected 
object(s).

Zoom Work Area Reverts to normal view after using various 
zoom options. (The same as  .)

All Windows If enabled,   and   affect all viewing 
panes.

Perspective/Parallel When selected, the tray is displayed with depth 
perspective—closer objects appear bigger. 
When not selected, the tray is displayed in two 
dimensions—identical objects appear the same 
size, regardless of their position on the screen.

Zoom By Rectangle Fills the active viewing pane with an area of the 
build tray after you select it with the mouse.

Zoom Dynamic Continuously zooms in/out of the point at 
which you click and hold down the left mouse 
button, when you move the cursor up and 
down.

Pan By Line Moves the build tray in the viewing pane 
according to the line you extend on the screen 
with the left mouse button.

Pan Dynamic Moves the build tray in the viewing pane as 
you move the cursor on the screen while 
holding down the left mouse button.

Walk Dynamic Zooms and moves the build tray as you hold 
down the left mouse button and move the 
cursor on the screen.

Study Dynamic Enables you to inspect the build tray from 
every angle and perspective. As you hold 
down the left mouse button and move the 
cursor on the screen, the view of the build tray 
changes.

Spin Mode When used with  ,   and  , the movement 
of the build tray continues after you release the 
mouse button. To stop the movement, click in 
the active view pane or click one of these icons.

Zoom In Each mouse click zooms one step to the center 
of the active viewing pane.

Zoom Out Each mouse click zooms‐out one step from the 
center of the active viewing pane.
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Pan Left Each mouse click moves the build tray to the 
left in the viewing pane by one step.

Pan Right Each mouse click moves the build tray to the 
right in the active viewing pane by one step.

Pan Up Each mouse click moves the build tray up in 
the active viewing pane by one step.

Pan Down Each mouse click moves the build tray down in 
the active viewing pane by one step.

Advance Forward The same as  . Each mouse click zooms in to 
the tray displayed in the active viewing pane.

Advance Backward The same as  . Each mouse click zooms out 
of the tray displayed in the active viewing 
pane.

Rotate Left Each mouse click rotates the build tray to the 
left in the active viewing pane by one step.

Rotate Right Each mouse click rotates the build tray to the 
right in the active viewing pane by one step.

Rotate Up Each mouse click rotates the build tray up in 
the active viewing pane by one step.

Rotate Down Each mouse click rotates the build tray down in 
the active viewing pane by one step.

Camera Displays a virtual camera and its viewing angle 
of the tray.

Icon Tool Tip Name Purpose



Using Objet Studio

5–32  DOC-13000 Rev. E

Handling Completed Trays
After you have properly placed all objects on the build tray, you save the 
tray as an objtf file, which is sent to the 3‐D printer for production. But 
before saving the tray, you can check that there would be no problem 
producing it. You can also calculate how much material would be 
consumed during production and how much time this would take.

Tray Validation Before sending a job to the Connex printer for production, you should 
check that the tray is “valid” and can be printed.

Note: Because of the unique characteristics of each type of modeling 
material, make sure that the correct material is selected before 
performing Tray Validation.

To validate that the tray can be printed:
From the Tools menu, select Tray Validation.

or—
Click  .
If the tray is not valid, the color of the problematic models on the tray 
changes according to a pre‐set color code. If a warning message appears, 
click OK to close it.

Figure 5-48: Tray validation warning

To view the color code for objects displayed:
From the Tools menu, select Constraints Settings.

Figure 5-49: Constraints Settings dialog box, showing object color codes
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Production 
Estimates

Objet Studio enables you to calculate the time and material resources 
needed for producing trays before sending them to the Connex printer. The 
time it takes Objet Studio to make this calculation depends on the number 
of objects on the tray and their complexity. Calculating the production 
estimate for a full tray could take up to 15 minutes, depending on your 
computer’s specifications. The results displayed are accurate within 10 
percent of the actual resources needed.

To calculate the time and materials needed for producing the current 
tray:

From the Tools menu, select Estimate Consumptions.
or—

Click  .
When Objet Studio finishes calculating the production resources, the 
results are displayed in one of the following dialog boxes.

Figure 5-50: Production resource calculations for different printing modes

Figure 5-51: Production resource calculation—Digital Material mode only

As shown in the Production Estimates dialog box, the resources needed for 
producing the models on the tray depend on the printing mode used by the 
printer when producing the job. You might want to consider these 
estimates when deciding on the printing mode (see below) and whether or 
not to allow using substitute model materials when printing the job. 

Note: You select the printing mode and material substitute options after 
you send the build tray to the printer (see “Printing the Tray File” on 
page 35).
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Printing Modes Connex printers can build models using three possible printing modes.

High Quality Mode—
• Models are printed in 16‐micron layers, resulting in smooth surfaces, 

suitable for producing fine details and delicate items.
• Almost twice as much time is required to print most trays, compared to 

the High Speed setting.
• This setting is only available when using all four print heads in single‐
material printing.

High Speed Mode—
• Models are produced in 30‐micron layers, suitable for producing larger 

models.
• Much less time is required to print most trays, compared to the 

High Quality setting.
• This setting is only available when using all four print heads in single‐
material printing.

Digital Material Mode—
• Used when producing models designed to be made from two different 

model materials.
• Used when producing a tray containing two or more models, each 

designed to be made from a different (single) model material.
• Used when producing models from only one of the model materials 

loaded in the printer by printing with two of the four print heads. 
• Models are produced in 30‐micron layers, but the printing is near‐high 

quality.
• Printing time is similar to printing time in High Quality mode.

Although printing time is longer than with High Speed mode, Digital 
Material mode can make material replacement unnecessary—saving 
both time and the cost of wasted model material.

You can see estimates of time and material resources needed for printing 
trays using the different printing modes (see “Production Estimates” on 
page 33). You also see these production estimates when you send the build 
tray to the printer. At that time, you can select the printing mode, including 
an option that enables Objet Studio to print the build tray by the most 
efficient method (see “Printing‐Mode Selection” on page 36).

Single-material printing: All print heads print models without regard to the 
source of the model material. This happens in the following situations:

• All print heads are supplied with one model material.
• Each pair of print heads is supplied with a different model material, but 

models are printed as if they were the same material. The result is an 
arbitrary mixture of materials in the printed model.

Digital Material Mode is selected automatically when more than one model 
material is assigned to objects on the build tray.
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Saving the 
Tray File

Trays are saved as objtf files. You can save a tray before it is ready for 
production, and open it at another time to continue preparing it. When you 
send the tray to the Connex printer, it is first saved. If the tray was 
previously saved, its objtf file is overwritten at this time.

To save the tray file:
From the File menu, select Save Tray or Save Tray As.

or—
Click  .

Printing the 
Tray File

When a tray is ready to be printed, it is sent to Job Manager, where it is 
placed in the print queue. When the job reaches the head of the queue, Job 
Manager pre‐processes the tray file to create slices, and feeds them to the 
3‐D printer.

To send the tray to the print queue:
1. From the File menu, select Build Tray.

or—
Click  .
• If printing the tray requires two model materials (Digital Material 

mode), the Job Summary dialog box opens. 

Figure 5-52:Job Summary when printing with two model materials

Note:The values displayed are the result of a quick calculation, and 
represent a rough estimate of the materials and time required to print the 
job. For a more accurate calculation, click Fine Estimation.

Continue with step 4 on page 37.
• If printing the tray requires only one model material, the Printing 
Mode Selection dialog box opens.

Figure 5-53:Printing Mode Selection dialog box

Note:The values displayed are the result of a quick calculation, and 
represent a rough estimate of the materials and time required to print the 
job. For a more accurate calculation, click Fine Estimation.
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Printing-Mode
Selection

2. Select the appropriate printing mode.
• If you require the job to be printed in High Quality mode, select this 

option.
• If you require the job to be printed in High Speed mode, select this 

option.
• If you do not require the job to be printed either in High Quality or 

High Speed mode, select Automatic. 
This setting enables the Connex software to determine (just before 
printing) the most efficient way to print the tray. Digital Material 
mode is used if this saves the need to perform the Material 
Replacement procedure. Otherwise, High Speed mode is used.
For example, if printing the tray requires only one of the two model 
materials loaded in the printer, only the two print heads using that 
material are used to print models—Digital Material mode. (High 
Quality and High Speed modes require printing with all four heads, 
which would require you to perform the Material Replacement 
procedure.) 
On the other hand, if printing the tray can be done using all four 
print heads without running the Material Replacement procedure, 
High Speed mode is used to print models. This is possible if all print 
heads are supplied with one model material, or if you allow printing 
with an arbitrary mixture of similar materials (see “Model Material 
Substitution,” below).

3. Click Next.
The Model Material Substitution dialog box opens—if this is relevant for 
the build tray. (If not, the Job Summary dialog box opens—continue with 
step 4.)

Model Quality When Digital Material Mode is Used

• Near-high-quality is achieved for most models. 
• A tray of objects inserted from stl files are printed with the standard 

600 dpi (dots per inch) resolution along the Y-axis—unless glossy finish 
is required (see “Surface Finish” on page 25).

• If there is an assembly on the build tray, all of the models on the tray are 
printed with a resolution of 300 dpi along the Y-axis. 
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Model Material
Substitution

Figure 5-54: Model Material Substitution dialog box

If you allow the use of substitute model materials, the printer will use 
different materials whose characteristics (strength, flexibility, etc.) are 
similar to those of the material you assigned to the object when 
designing the build tray—under the following conditions:
• The material you assigned is not installed in the printer at the time 

of printing.
In this case, the tray is printed with either one or two substitute 
materials (depending on the materials installed in the printer at the 
time of printing). If possible, High Speed mode is used.

• In addition to the material you selected, there is another (similar) 
material installed in the printer at the time of printing.
In this case, High Speed mode is used, by printing with a mixture of 
the two materials (as if they were the same material).

4. Click Build.
If the build‐tray file has not been saved, the Save As dialog box opens 
for you to save it now.
Objet Studio checks if there is a problem with the positioning of objects 
on the tray. If so, the affected objects are displayed with special colors 
(see figure 5‐49 on page 5‐32), and the following warning message 
appears.

Figure 5-55: Tray validation warning

• To cancel the Build command so you can correct the problem, click 
No.
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• To print the models as they are positioned on the tray, click Yes.

Figure 5-56: Constraints Settings dialog box, with color codes for problematic 
model positioning

The tray file is sent to Job Manager. Objet Studio closes and Job Manager 
opens, so you can monitor the progress of your trays—before, during, and 
after printing.

To return to Objet Studio from Job Manager, click New Job .
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Additional Objet Studio Features
Dividing 
Objects

You can use the Split Object feature to produce objects larger than the build 
tray by dividing the model into separate parts. With this feature, you 
produce only a specific section of a model.

To split an object:
1. Select the object.
2. From the Object menu, select Split.
3. In the Split Object dialog box, enter the values to determine how Objet 

Studio will divide the object. You can divide an object along any of its 
axes, by entering either exact measurements or the number of parts.

Figure 5-57: Split Object dialog box

4. In Save to Folder, enter the folder name.
5. Click OK.

The composite parts are saved as new stl files with “Part 1,” “Part 2,” 
etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you 
check them for defects in an STL-repair application, such as Magics, 
by Materialise. 

Choosing the 
Support 
Strength

When producing models, support material fills some hollow and empty 
sections (see “Model Orientation” on page 5‐18). Objet Studio allows you to 
adjust the strength of the structure formed with the support material. This 
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate 
support strength.

To change the strength of the support structure used when printing a 
model:
1. Select a model on the build tray.
2. In the Options tab of the object properties dialog box, click Advanced.

The Advanced Properties dialog box opens.
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Figure 5-58: Advanced Properties dialog box—Grid Style selection

3. In the Grid Style section, choose the support strength suitable for the 
selected model:
• Heavy—for large models needing much support.
• Lite—for delicate models needing little support.
• Default—for models needing average support (most models).
Note: You can select a different support strength for each model on the 
build tray.

4. Click Apply.

“Smartcast”—
Filling Models 
with Support 
Material

Many objects placed on the build tray from stl files are “solid.” This means 
that, when printed, the model will be completely filled with model 
material. Often, especially with large objects, this is unnecessary. Instead, 
the model can be filled with support material, which is less costly. It is also 
advisable to fill models with support material when preparing them for 
investment casting, since this material burns off more quickly during the 
process of making the cast.
Objet Studio enables you to print objects on the build tray with an outer 
shell of model material and a center filled with support material. This 
feature of Objet Studio is called “Smartcast/Hollow.” You can set the 
thickness of the shell—between 0.015 and 3.825 millimeters.

To use the Smartcast/Hollow feature:
1. Select a model on the build tray.
2. In the Options tab of the object properties dialog box, click Advanced.

The Advanced Properties dialog box opens (see figure 5‐58).
3. Select the Smartcast/Hollow check box.
4. Set the shell thickness, in millimeters.
5. Click Apply.

Note: There is no change in the display of objects in Objet Studio when the 
Smartcast/Hollow feature is used.

To inspect, change or cancel the Smartcast/Hollow setting:
1. Select a model on the build tray.
2. Access the Advanced Properties dialog box, as above.
3. If you change or cancel the Smartcast/Hollow setting, click Apply.

The Lock Orientation and Smartcast/Hollow options are not connected to 
the Grid Style selection. Lock Orientation is described in “Freezing an 
Object’s Orientation” on page 5-25. Smartcast/Hollow is described below.
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Displaying the 
Cross Section 
of Objects

The Section feature enables you to view the interior of an object by “slicing” 
it on any axis. You can then manipulate the object to inspect the interior 
from different angles. This may be important for deciding on the type of 
support necessary when producing the model (see “Choosing the Support 
Strength” on page 5‐39). Displaying an object’s cross section only affects 
how the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

or—
Click   on the toolbar.
The Section dialog box opens.

Figure 5-59: Section dialog box

2. Select the Enable Clicking check box.
3. Use the slider controls for the X‐, Y‐, and Z‐axes to cut the tray so that 

you see the cross section you want.

Printing the 
Screen Display 
on Paper

You can print the view displayed in the active pane on a regular (paper) 
printer. Before printing, you can configure how the tray will be printed on 
the page, and you can display a screen preview of the printed page.

To access the paper printing controls:
From the File menu, select—

Page Setup…
Page Preview…
Print 

You can also print a paper copy of the tray by using the standard Windows 
keyboard shortcut for printing: Ctrl+P.

Figure 5-60: Whole view Figure 5-61: Cross-section view, after 
using the Z-slider
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Saving the 
Screen Display 
as an 
Image File

You can save the image displayed in the active viewing screen as a graphic 
file.

To save the screen display as an image:
1. From the File menu, select Save Bitmap…

The Save Bitmap dialog box opens.

Figure 5-62: Save Bitmap dialog box

2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type pull‐down menu, and select the file format.
5. Click Save.

Exporting and 
Importing 
Objet Build 
Trays

When you save build trays in Objet Studio, they are saved as objtf files. 
These files contain instructions to Objet Studio and to Connex printers for 
displaying and producing the stl files used on the tray. To conveniently 
save all of the files that comprise the build tray, for storing the job, or for 
transferring it to another location, Objet Studio compresses them into one 
objzf file. To later use the objzf file, the file must first be expanded in Objet 
Studio and its component files saved.

To create an objzf file:
1. From the File menu, select Export Packed Job…

The Save As dialog box opens.
2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:
1. From the File menu, select Import Packed Job…
2. In the Open dialog box, display the appropriate folder and select the 

file.
3. In the Browse for Folder dialog box, display the folder in which you 

want Objet Studio to expand the compressed file, and click OK.
The objtf file and associated stl files are expanded and placed in the 
selected folder, and the tray is displayed in Objet Studio.
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Advanced-Mode Features
The Objet Studio features described in this section are only accessible if the 
application is set to Advanced mode. 

To see the current Objet Studio setting:
Open the Tools menu.

Figure 5-63: Tools menu, showing Advanced mode selected

If Advanced is checked, the advanced features are enabled. 

To change the Advanced setting:
1. Click Advanced in the Tools menu.

The following message is displayed, reminding you that the change 
will only take effect the next time you open Objet Studio—even though 
the check mark in the Tools menu appears/disappears after you make 
the change.

Figure 5-64: Configuration-change message

2. Close and re‐open Objet Studio to access the Advanced mode features.
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Save Tray As… In addition to saving the tray as an objtf file, for producing it with an 
Connex 3‐D printer, you can save a group of objects positioned on the tray 
as an stl file. You can then use this file as any other stl file, both in Objet 
Studio and in other applications. You can also display this and other stl files 
as “floating” objects, without the build tray. This is useful for inspecting 
objects from every angle.

To save the build tray as an stl object:
1. From the File menu, select Save Tray As…

Figure 5-65: Save As dialog box

2. At the top of the dialog box, select the appropriate folder.
3. At the bottom of the dialog box, enter a file name.
4. Open the Save as type pull‐down menu, and select STL Files (*.stl).
5. Click Save.

To display stl files without the build tray:
1. From the File menu, select Open Tray.
2. In the Open dialog box, open the Files of type pull‐down menu, and 

select STL Files (*.stl).
3. Click Open.

A three‐dimensional image of the file is displayed. You can use many of 
the Objet Studio tools to manipulate the image on the screen.
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Configuring 
the GL Driver

The OpenGL driver displays 3‐D graphics on your screen. There is 
normally no reason to adjust its settings. If you suspect a problem with the 
way Objet Studio displays objects, you can use the OpenGL Driver 
Configuration tool to check and configure the driver settings. 

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
2. In the Options dialog box, display the Advanced tab and click OpenGL 

Driver Configuration…

Figure 5-66: Accessing GL-driver configuration

Note: If the Advanced tab is not displayed, activate the Advanced option in 
the Tools menu and re-open Objet Studio.
The dialog box that opens contains tabs that display the pixel format ID 
(index) for the window and the memory.

Figure 5-67: OpenGL Driver Configuration dialog box

You can display the values and make changes to them by clicking  . 
Alternately, you can select Choose Format and change the values in this 
dialog box.
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To perform a test of the driver configuration and enter the suggested 
pixel format ID:
1. Select Choose Format. 
2. Click Test.

Objet Studio returns the recommended pixel format ID.

Figure 5-68: Recommended pixel format ID

3. Click OK. 
4. In the OpenGL Driver Configuration dialog box (figure 5‐67), select 

Pixel Format ID and enter this number.
5. Click Apply.
6. Display the other pixel format tab, and repeat this procedure.
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The Job Manager application is different for client workstations and for the 
computer connected directly to the 3‐D printer. 
• Job Manager installed on client computers displays the queue and 

status only for jobs sent to the 3‐D printer server from that computer, 
and allows the user to edit only these jobs. 

• Job Manager installed on the computer directly connected to a specific 
3‐D printer displays the queue and status for all jobs sent to that 3‐D 
printer by client computers on the network. It also allows editing and 
manipulation of all jobs, and enables re‐sending previously‐printed 
jobs to the printer.

Client Job Manager
When you open the client Objet Studio / Job Manager software for the first 
time, a dialog box opens prompting you to connect to an Objet server 
computer. To do this, the server computer must be operating and connected 
to the local network. 

Click Browse to find and select the name of the required server 
computer and then click OK to close the dialog box.

Figure 6-1: Server connection dialog box

To change the server-computer connection (to connect to another 
printer):

From the Job Manager screen, click the Connect icon   on the toolbar, 
or open the 3‐D Printer menu and select Set Printer.

If there are several Connex printers on the local network, client computers 
can connect to any of them, but only one at a time.
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Job Manager 
Screen

On a client computer, Job Manager displays the queue of jobs sent by that 
computer to the printer server.

Figure 6-2: Client Job Manager screen

Information for each of the queued jobs is displayed, including the job 
status:

Print Queue

Print History

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Paused Printing of this job began, but was interrupted by the 
administrator before being completed.

Stopped Printing of this job was terminated by the administrator, 
and was put in the print queue again.

Error Errors occurred during the printing of this job, and it was 
placed in the print queue again.

Editing This job is now being edited in Objet Studio.

Previewing The operator at the server computer is inspecting the 
model’s slices.

Spooling The job file is being spooled in the printer.

Preprocessing The 3‐D printer is readying itself for printing: the cover 
locks, print heads warm up and are put in starting 
position, UV lamps are turned on, build‐tray level is 
adjusted.
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Job Manager 
Operations

Even after sending a build tray to the 3‐D printer, you can inspect the tray—
and make changes to it, if necessary—as long as it is still in the print queue.

To inspect the build tray:
1. Select the job.
2. Click the Edit Job icon   or open the Job menu and select Edit.

Objet Studio opens, displaying the build tray. To make changes to it, see 
“Making changes to a Job” on page 6‐9.

The following operations are available from the client Job Manager 
interface:

The 3‐D printer Status screen enables clients to monitor the progress of 
printing jobs. To display the screen, click the Machine Status icon  .

Configuring 
User Alerts

Job Manager can alert you and others to the status of the jobs sent to the 
server for printing. The following events can be reported:
• The level of model or support material is low.
• The job was interrupted.
• The job was completed successfully.

Icon Menu Option Purpose

3‐D Printer > 
New Job

Launches Objet Studio; to prepare new trays.

3‐D Printer > 
Set Printer

Displays a network‐browsing dialog box, to 
connect to an Objet server computer. To specify 
a computer, it must be operating and 
connected to the local network.

—— Displays the status of the 3‐D printer.

3‐D Printer > Report Displays options for user messages and alerts 
(paper printer, e‐mail, SMS—see “Configuring 
User Alerts” on page 6‐4).

Job > Delete... Removes the selected job from the queue.

Job > View… Opens a window displaying the selected tray. 
In this window, you can view the tray from 
different angles.

Job > Properties Opens a window displaying the properties of 
the selected model.

Job > Edit Launches Objet Studio and loads the current 
tray, to enable making changes to the tray after 
it is sent to the server but before it is printed.

Help > About... Displays the Job Manager version.
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To send e‐mail and SMS messages, make sure that e‐mail software 
supporting MAPI is installed on the printer’s server computer. To send SMS 
messages, the cellular phone service must support the transmission of e‐
mail messages by SMS. With SMS alerts, only the subject line of the e‐mail 
message is transmitted.

Note: In the e-mail program, make sure the security settings are set to 
“low” and add the server Job Manager to the “trusted” list (select 
Tools > Options, Security tab).

To configure Job Manager to send notifications and alerts for your jobs:
1. Click   or select Report from the 3‐D Printer menu.

The Preferences/Reports dialog box opens.

Figure 6-3: User alerts settings 

2. For e‐mail and SMS alerts, click Add Recipient in the respective 
sections.

3. To choose the events reported to you by Job Manager, click Details in 
the relevant sections.

Figure 6-4: Event selection for alerts

4. Select the desired events for sending alerts and click OK.

The parameters for “Low level of material” alerts are set on the printer’s 
server computer.




